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・ The information in this document is current as of January 2005. The information is subject to change 
without notice. For actual design-in, refer to the latest publications of NEC Electronics data sheets or 
data books, etc., for the most up-to-date specifications of NEC Electronics products. Not all products 
and/or types are available in every country. Please check with an NEC sales representative for 
availability and additional information. 

 
・ No part of this document may be copied or reproduced in any form or by any means without prior 

written consent of NEC Electronics.  NEC Electronics assumes no responsibility for any errors that 
may appear in this document. 

 
・ NEC Electronics does not assume any liability for infringement of patents, copyrights or other 

intellectual property rights of third parties by or arising from the use of NEC Electronics products listed 
in this document or any other liability arising from the use of such NEC Electronics products.  No 
license, express, implied or otherwise, is granted under any patents, copyrights or other intellectual 
property rights of NEC Electronics or others. 

 
・ Descriptions of circuits, software and other related information in this document are provided for 

illustrative purposes in semiconductor product operation and application examples.  The incorporation 
of these circuits, software and information in the design of customer's equipment shall be done under 
the full responsibility of customer.  NEC Electronics no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information.  

 
・ While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics 

products, customers agree and acknowledge that the possibility of defects thereof cannot be 
eliminated entirely.  To minimize risks of damage to property or injury (including death) to persons 
arising from defects in NEC Electronics products, customers must incorporate sufficient safety 
measures in their design, such as redundancy, fire-containment and anti-failure features. 

 
・ NEC Electronics products are classified into the following three quality grades: “Standard”, “Special” 

and “Specific”. 
 

The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated “quality assurance program” for a specific application.  The recommended applications of NEC 
Electronics product depend on its quality grade, as indicated below.  Customers must check the quality 
grade of each NEC Electronics product before using it in a particular application. 
 
"Standard": Computers, office equipment, communications equipment, test and measurement 
  equipment, audio and visual equipment, home electronic appliances, machine tools, 
  personal electronic equipment and industrial robots. 
 
"Special":  Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti- 
   disaster systems, anti-crime systems, safety equipment and medical equipment (not 
   specifically designed for life support). 
 
"Specific":  Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems,  
   life support systems and medical equipment for life support, etc. 
 
The quality grade of NEC Electronics products is “Standard” unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc. If customers wish to use NEC Electronics products in 
applications not intended by NEC Electronics, they must contact NEC Electronics sales representative in 
advance to determine NEC Electronics 's willingness to support a given application. 
 
Notes:  1." NEC Electronics" as used in this statement means NEC Electronics Corporation and also 
    includes its majority-owned subsidiaries. 

 2. " NEC Electronics products" means any product developed or manufactured by or for NEC 
  Electronics (as defined above). 

 
M8E 02.10 
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K_Line – Play it!-2 complies with the EMC protection requirements 
 
 
 
 

WARNING 
 
This is a ‘Class A’ (EN 55022 : 1998) equipment. This equipment can cause radio 
frequency noise when used in the residential area. In such cases, the user/operator of 
the equipment may be required to take appropriate countermeasures under his 
responsibility. 

EEDT-ST-001-11 
 
 
 
 
 

CAUTION 
 

This equipment should be handled like a CMOS semiconductor device. The user must 
take all precautions to avoid build-up of static electricity while working with this 
equipment. All test and measurement tool including the workbench must be grounded. 
The user/operator must be grounded using the wrist strap. The connectors and/or 
device pins should not be touched with bare hands. 

EEDT-ST-004-10 
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1. Introduction 
K_Line  – Play it!-2 is a demonstration kit for the NEC’s K_Line 78K0 / V850ES microcontroller family. It 
supports onboard FLASH programming and real time execution of application programs up to 4 kBytes 
of program code for the 78K0 CPU module and up to 16 kBytes of program code for the V850 CPU 
module. The board is prepared to be connected to user hardware parts such as digital I/O or analogue 
signals. 

1.1 Main features of K_Line  – Play it!-2 

• Easy to use device demonstration capabilities 
K_Line - Play it!-2 contains elements to easily demonstrate simple I/O-functions, i.e. push buttons, 
12*2 character LC display, LED output, AD reference voltage, I/O lines, UART serial interface. 

 
• Power supply via USB interface 

K_Line - Play it!-2 is powered via USB interface, no separate power supply is needed. 
 

• Character LCD module 
K_Line - Play it!-2 provides a 12*2 character LC display, allowing the implementation of human / 
machine interface, comfortable input / output functions, output of measurement values, output of 
status information etc.  
 

• FPL, FLASH programming software 
A windows based FLASH programming software allows to select and download application programs 
to the K_Line - Play it!-2 board for evaluation purposes. 

 
• Analogue to digital signal conversion is supported 

 
• Various input / output signals available, such as 
 

° All I/O ports prepared to be connected to user hardware 
° Timer input / output signals 
° Two or three wire serial I/O 
° UART interface, via USB UART chip FT232 
° LIN bus support, via TJA 1020 transceiver 
° 8 analogue input lines 
° Temperature sensor KTY13-5 
° 4 I/O ports connected to LED 
° 2 push buttons prepared for external interrupt generation 
 

• The IAR Embedded Workbench for 78K0/78K0S and the IAR C-SPY debugger / simulator are 
included. These packages are restricted in such that maximum program code size is limited to 4 
kByte of program code. 

 
• The IAR Embedded Workbench for V850 and the IAR C-SPY debugger / simulator are included. 

These packages are restricted in such that maximum program code size is limited to 16 kByte of 
program code. 

 
• Full documentation is included for the NEC 78K0/KF1+, NEC V850ES/KG1+, IAR Systems 

Embedded Workbenches, IAR Systems C-SPY debugger / simulator and the NEC FPL FLASH 
programming software. 
 

K_Line - Play it!-2 is not intended for code development. NEC does not allow and does not 
support in any way any attempt to use K_Line - Play it!-2 in a commercial or technical product. 
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1.2 System requirements 

 
HOST PC A PC supporting Windows 98SE, Windows ME, Windows 2000 or 

Windows XP is required for the IAR Systems Embedded Workbench 
demo-version and the FPL FLASH programming software. 
Pentium 166 MHz (at least), 128 MB of RAM, 256-color display (1024 * 
768), mouse, CD-ROM drive and 200 Mbytes of free hard disk space are 
required to install the tool packages. 
 
Above listed requirements are valid for the IAR Systems Embedded 
Workbench and the FPL FLASH programming software. 
 

Host interface USB interface that enables communication based on USB (Ver1.1 or 
later) 
 

1.3 Package contents 

Please verify that you have received all parts listed in the package contents list attached to the  
K_Line - Play it!-2 package. If any part is missing or seems to be damaged, please contact the dealer 
from whom you received your K_Line - Play it!-2. 
 
Note: Updates to this User Manual, additional documentation and/or utilities for K_Line - Play it!-2, if 

available, may be downloaded from the NEC WEB page(s) at http://www.ee.nec.de/updates. 
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2. K_Line - Play it!-2 system configuration 
 
The K_Line - Play it!-2 system configuration is given in the diagram below: 
 
 

 

Figure 1: K_Line - Play it!-2 system configuration 

2.1 K_Line - Play it!-2 
K_Line - Play it!-2 is a demonstration kit for the NEC K_Line family devices. Two K_Line CPU modules 
are included, one is based on the 78K0/KF1+ device as a typical device from K_Line with the 78K0 8-Bit 
CPU core and the second one based on the V850ES/KG1+ device as a typical device with the V850ES 
32-bit CPU core. 
 
The K_Line - Play it!-2 board is connected to the host system via USB interface cable. The host system 
may be used for onboard FLASH programming of 78K0/KF1+ and V850ES/KG1+ internal FLASH 
memories and to allow execution of application programs on K_Line - Play it!-2 platform. 
 
K_Line - Play it!-2 runs both CPU modules at 8.0000 MHz operating speed. Sub-clock is provided with 
32.768 kHz. 
 

2.2 Host computer 
The USB host interface enables communication to the K_Line - Play it!-2 board. The USB UART chip 
FT232 allows application software to access the USB device in the same way as it would access a 
standard RS232 interface. The FTDI's Virtual COM Port ( VCP ) driver appears to the windows system 
as an extra Com Port, in addition to any existing hardware Com Ports.  
 
For a detailed specification of the host interface please refer to the CHAPTER 12 CONNECTORS AND 
CABLES of this document. 
 

2.3 Power supply via USB interface 
K_Line - Play it!-2 is powered by USB interface, no separate power supply is needed. The USB interface 
provides the K_Line - Play it!-2 board with 5V supply voltage. 
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3. K_Line - Play it!-2 baseboard components 
 
The K_Line - Play it!- 2 baseboard is equipped with push buttons, a 12*2 character LC display, LED’s and 
with several connectors in order to be connected to host computers or FLASH programmer. 
 

 

Figure 2: K_Line - Play it!-2 baseboard connectors, switches and LED’s 

 
 
Some of the K_Line - Play it!-2 components are free for user application hardware and software. Please 
read the user’s manual of the 78K0/KF1+ and the V850ES/KG1+ device carefully to get information 
about the electrical specification of the available I/O ports before you connect any external signal to the 
K_Line - Play it!-2 board. 
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3.1 RESET button SW1 

SW1 is a reset button. It activates the power on reset. It is connected to the reset input of the CPU 
module. 

3.2 User button SW2 
SW2 is a push button connecting VCC to external interrupt input INTP0 of the CPU module. This is equal 
to port P120 of the 78K0 CPU module and port P03 of the V850 CPU module. The port may be 
programmed to generate interrupt INTP0. The necessary initialisation for this purpose is described in the 
user’s manual of the 78K0/KF1+ and the V850ES/KG1+ device. The port is connected to a 1.2K pull 
down resistor. 

3.3 User button SW3 
SW3 is a push button connecting VCC to external interrupt input INTP1 of the CPU module. This is equal 
to port P30 of the 78K0 CPU module and port P04 of the V850 CPU module. The port may be 
programmed to generate interrupt INTP1. The necessary initialisation for this purpose is described in the 
user’s manual of the 78K0/KF1+ and the V850ES/KG1+ device. The port is connected to a 1.2K pull 
down resistor. 
 

3.4 Configuration switch SW4 
The different operation modes of the K_Line - Play it!-2 board can be set by SW4 switches S1-S4.  
 

SW4 Factory settings 78K0/KF1+ V850ES/KG1+ 
S1 OFF Normal operation mode Normal operation mode 
S2 OFF CPU clock = 8 MHz CPU clock = 8 MHz 
S3 OFF UART6 select UART0 select 
S4 OFF LIN bus disabled LIN bus disabled 

Table 1: Configuration switch SW4, factory settings 

 

3.4.1 Operation mode selection SW4/S1 
SW4 switch S1 controls the operation mode of the K_Line - Play it!-2 board. Setting SW4/S1 to ON 
allows to reprogram the internal FLASH memory of the 78K0/KF1+ and V850ES/KG1+ device using the 
FPL FLASH programming software. 
 
 

SW4, S1 Operation mode 
OFF (default) Normal operation mode 
ON FLASH memory programming mode 

Table 2: Operation mode selection SW4/S1 

 
Within normal operation mode the user program stored in the FLASH memory of 78K0/KF1+ and 
V850ES/KG1+ device is executed. 
 

3.4.2 Clock mode / OCD mode selection SW4/S2 

SW4 switch S2 controls the clock operation frequency of the K_Line - Play it!-2 board when using the 
V850 CPU module. By using the 78K0 CPU module switch S2 selects the on-chip debug function of the 
78K0/KF1+ device. Setting switch S2 to ON allows, connecting the QB-78K0MINI on-chip debug 
emulator to the K_Line – Play it!-2 78K0 CPU module, connector CN7. 
 

SW4, S2 78K0/KF1+ V850ES/KG1+ 
OFF (default) Clock frequency = 8 MHz Clock frequency = 8 MHz 
ON enable on-chip debugging  Clock frequency = 4 MHz 

Table 3: Clock mode / OCD mode selection SW4/S2 



K_Line - Play it! - 2  

14 

 

3.4.3 UART selection SW4/S3 

SW4 switch S3 specifies the corresponding UART signals connected to the FT232 interface lines. 
 
 

SW4, S3 78K0/KF1+ V850ES/KG1+ 
OFF (default) UART6 select UART0 select 
ON UART0 select UART1 select 

Table 4: UART selection SW4/S3 

 

3.4.4 UART/ LIN mode SW4/S4 
SW4 switch S4 controls the serial communication mode of K_Line - Play it!-2 board. The corresponding 
UART signals RxD and TxD selected by SW4/S3 are connected to the TJA1020 LIN transceiver when 
setting SW4/S4 to ON. Setting SW4/S4 to OFF connects the UART signals to the FT232 interface lines. 
 
 

SW4, S4 Operation mode 
OFF (default) UART mode 
ON LIN mode 

Table 5: UART / LIN selection SW4/S4 

 

3.5 LIN plug JP1  
JP1 is a 3 pin connector for the LIN bus, connected to the transceiver TJA1020. 
 

JP1 Signal Description 
1 BAT Reference voltage for the LIN bus level 
2 LIN LIN bus line 
3 GND Ground 

Table 6: LIN plug JP1 

3.6 USB interface connector CN6 

CN6 connector allows connecting the FPL FLASH programming software to the K_Line - Play it!-2 board 
in order to program application programs into the CPU internal flash. The board power supply of 5V is 
also provided by connector CN6. 
 
Additionally connector CN6 connects optionally UART6/0 of the 78K0/KF1+ device and UART0/1 of the 
V850ES/KG1+ device to the host system. 
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3.7 Connector CN4 

CN4 connector (not assembled) allows connecting the PG-FP4 flash programmer to K_Line – Play it!-2 
board in order to program application programs into the CPU internal flash memory of the connected 
CPU module. Please note, PG-FP4 is a separate product from NEC and it is not included in this 
package. 
 
 

CN4 Signal 
1 GND 

2 RESET 

3 SI 

4 VCC 

5 SO 

6 N.C. 

7 SCK 

8 N.C. 

9 N.C. 

10 N.C. 

11 N.C. 

12 FLMD1 

13 N.C. 

14 FLMD0 

15 N.C. 

16 N.C. 

Table 7: CN4, PG-FP4 connector 

 
When using PG-FP4, the programming interface to the 78K0/KF1+ and V850ES/KG1+ device must be 
set to clock serial interface, SIO-ch0 without handshake. Set configuration of switch SW4 of K_Line – 
Play it!-2 board to the following: 
 
 

SW4 Setting 
S1 OFF 
S2 OFF 
S3 OFF 
S4 OFF 

Table 8: SW4 configuration when using PG-FP4 

 

3.8 External Potentiometer R7 
A 47K potentiometer R7 is connected between Vcc and ground. The potentiometer arm is connected to 
the V0 signal of the LCD module. It controls the operating voltage - contrast adjustment - of the display. 
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3.9 Display D1, 12*2 character LC display 

The K_Line - Play it!-2 board is equipped with a character LC display D1. The display font is equal to 12 
character words at 2 lines. The LCD module contains about a character generator ROM - including 
predefined standard characters - and character RAM where user can rewrite characters by program. The 
display is connected to the 78K0 and V850 CPU module via three control lines and eight data lines. 
 
 

Display Pin Display Signal Port 78K0/KF1+ Port V850ES/KG1+ Play it!-2 board 
1 Vss - - GND 
2 Vcc - - Vcc 
3 V0 - - R7 potentiometer 

arm 
4 RS P66 PCT4 - 
5 R/W P65 PCT1 - 
6 E P64 PCT0 - 
7 DB0 P40 PDL0 - 
8 DB1 P41 PDL1 - 
9 DB2 P42 PDL2 - 

10 DB3 P43 PDL3 - 
11 DB4 P44 PDL4 - 
12 DB5 P45 PDL5 - 
13 DB6 P46 PDL6 - 
14 DB7 P47 PDL7 - 
15 A - - Vcc via diode 

Table 9: Display connections 

 
For more details about the LC display specification, commands and character table, please refer to the 
corresponding User’s Manual “WH1202A-NFA-ET.pdf” located in the /doc folder of the K_Line – 
Play it!-2 CDROM. 
 

3.10 External Potentiometer R14 

A 47K potentiometer R14 is connected between Vcc and ground. The potentiometer arm is connected to 
port P20 of 78K0/KF1+ and P70 of V850ES/KG1+ device. This is equal to the ANI0 analogue input. 
 

3.11 AD converter reference voltage input 
A 1.2V reference voltage is supplied to the ANI1 analogue input, equal to port P21 of 78K0/KF1+ and 
P71 of V850ES/KG1+ device. 
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3.12 Temperature sensor 

For temperature measurement and primarily as an application example a silicon temperature sensor 
KTY13-5 is connected to the ANI2 analogue input, equal to port P22 of 78K0/KF1+ and port P72 of 
V850ES/KG1+ device. 
 
The temperature sensor has a resistor range of R25 min = 1950 Ω and R25 max = 1990 Ω at 25 degrees 
centigrade, with IOP = 1mA. The distribution of the temperature factor kT is shown in the table below: 
 

 
Table 10: Distribution of temperature factor kT 

 
The sensor resistance can be calculated as following:  RT =  kT * R25 =  ∫(TA) 

 

 

 
  1) Normalising point 
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3.13 External LED’s D1–D4 

LED’s D1 to D4 are connected to port P5 of the 78K0/KF1+ device. For the V850ES/KG1+ device port 
PCM is connected to LED’s D1 to D4. A low signal output at each port switches the corresponding LED 
on. 
 
 

LED Port 78K0/KF1+ Port V850ES/KG1+ 
D1 P50 PCM0 
D2 P51 PCM1 
D3 P52 PCM2 
D4 P53 PCM3 

Table 11: LED D1–D4 connection 
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4. K_Line - Play it!-2 CPU module components 
Both K_Line – Play it!-2 CPU modules are equipped with 4 connectors in order to be connected to user 
defined hardware. One is the 78K0/KF1+ CPU module and the other the V850ES/KG1+ CPU module. 
Additionally the 78K0/KF1+ CPU module contains about connector CN7 for on-chip debugging purpose. 
 

4.1 K_Line - Play it!-2, 78K0 CPU module 

 
                                  Figure 3: K_Line - Play it!-2, 78K0 CPU module components 

4.1.1 External connector CN3, CN4, CN5, and CN6 
CN3, CN4, CN5, and CN6 are connectors for external user hardware. 
 
CN3 Port 78K0/KF1+  CN4 Port 78K0/KF1+  CN5 Port 78K0/KF1+  CN6 Port 78K0/KF1+ 
1 AVREF  1 P13, TxD6  1 P03, SI11  1 P43, AD3 

2 AVSS  2 P14, RxD6  2 P02, SO11  2 P42, AD2 

3 P120, INTP0  3 P15, TOH0  3 P01, TI010, TO00  3 P41, AD1 

4 P33,TI51,TO51,INTP4  4 P16, TOH1, INTP5  4 P00, TI000  4 P40, AD0 

5 P32, INTP3  5 P17, TI50, TO50, FLMD1  5 P67, ASTB  5 P77, KR7 

6 P31, INTP2  6 P140, PCL, INTP6  6 P66, WAIT  6 P76, KR6 

7 P30, INTP1  7 P141, BUZ, BUSY0, INTP7  7 P65, WR  7 P75, KR5 

8 FLMD0  8 P63  8 P64, WD  8 P74, KR4 

9 VDD  9 P62  9 P57, A15  9 P73, KR3 

10 NC  10 EVSS  10 P56, A14  10 P72, KR2 

11 VSS  11 EVDD  11 P55, A13  11 P71, KR1 

12 X1  12 P61  12 P54, A12  12 P70, KR0 

13 X2  13 P60  13 P53, A11  13 P27, ANI7 

14 RESET  14 P142, SCKA0  14 P52, A10  14 P26, ANI6 

15 XT1  15 P143, SIA0  15 P51, A9  15 P25, ANI5 

16 XT2  16 P144, SOA0  16 P50, A8  16 P24, ANI4 

17 P130  17 P145, STB  17 P47, AD7  17 P23, ANI3 

18 P10, SCK10, TxD0  18 P06, TI011,TO01  18 P46, AD6  18 P22, ANI2 

19 P11, SI10, RxD0  19 P05, SSI11, TI001  19 P45, AD5  19 P21, ANI1 

20 P12, SO10  20 P04, SCK11  20 P44, AD4  20 P20, ANI0 

Table 12: CN3, CN4, CN5, and CN6 connection to 78K0/KF1+ 
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4.1.2 OCD connector CN7 

 
CN7 connector allows connecting the QB-78K0MINI on-chip debug emulator to the K_Line – Play it!-2 
78K0 CPU module in order to use on-chip debug function of the 78K0/KF1+ device. QB-78K0MINI is a 
separate product from NEC and it is not included in this starterkit package. 
 
 

CN7 Function 
1 RESET_IN 
2 RESET_OUT 
3 FLMD0 
4 VDD_IN 
5 X2 
6 GND 
7 X1 
8 GND 
9 N.C. 
10 N.C. 

Table 13: OCD connector CN7 

 
To enable on-chip debugging for the 78K0/KF1+ CPU module, please set switch SW4 to the following 
configuration: 
 
 

SW4 Setting 78K0/KF1+ 
S1 OFF Normal operation mode 
S2 ON enable on-chip debugging 
S3 don’t care UART6/0 select 
S4 don’t care  UART/LIN select 

Table 14: SW4 configuration for OCD 
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4.2 K_Line - Play it!-2, V850 CPU module 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   Figure 4: K_Line - Play it!-2, V850 CPU module components 

4.2.1 External connector CN3, CN4, CN5, and CN6 
CN3, CN4, CN5, and CN6 are connectors for external user hardware. 
 
CN3 Port V850ES/KG1+  CN4 Port V850ES/KG1+  CN5 Port V850ES/KG1+  CN6 Port V850ES/KG1+ 
1 AVREF0  1 P32, ASCK0, ADTRG, TO01  1 P98, SO01, A8  1 PDL6, AD6 

2 AVSS  2 P31, RXD0, INTP7, TO03  2 P99, SCK01, A9  2 PDL5, AD5, FLMD1 

3 P10, ANO0  3 P34, TI001, TO00, TIP01  3 P910, SIA1, A10  3 PDL8, AD8 

4 P11, ANO1  4 P33, TI000, TO00, TIP00  4 P911, SOA1, A11  4 PDL7, AD7 

5 AVREF1  5 P36  5 P912, SCKA1, A12  5 PDL10, AD10 

6 P00, TOH0  6 P35, TI010,TO01  6 P913; INTP4, A13  6 PDL9, AD9 

7 P01, TOH1  7 EVSS  7 P914, INTP5, A14  7 PDL12, AD12 

8 FLMD0, IC  8 P37  8 P915, INTP6, A15  8 PDL11, AD11 

9 VDD  9 P38, SDA0  9 PCS0, CS0  9 PDL14, AD14 

10 REGC  10 EVDD  10 PCS1, CS1  10 PDL13, AD13 

11 VSS  11 P50, TI011, RTP00, KR0  11 PCM0, WAIT  11 PDH0, AD16 

12 X1  12 P39, SCL0  12 PCM1, CLKOUT  12 PDL15, AD15 

13 X2  13 P52, TO50, RTP02, KR2  13 PCM2, HLDAK  13 PDH2, A18 

14 RESET  14 P51, TI50, RTP01, KR1  14 PCM3, HLDRQ  14 PDH1, A17 

15 XT1  15 P54, SOA0, RTP04, KR4  15 PCT0, WR0  15 PDH4, A20 

16 XT2  16 P53, SIA0, RTP03, KR3  16 PCT1, WR1  16 PDH3, A19 

17 P02, NMI  17 P90, TxD1, KR6, A0  17 PCT4, RD  17 P77, ANI7 

18 P03, INTP0  18 P55, SCKA0, RTP05, KR5  18 PCT6, ASTB  18 PDH5, A21 

19 P04, INTP1  19 P92, TI020, TO02, A2  19 BVSS  19 P75, ANI5 

20 P05, INTP2  20 P91, RxD1, KR7, A1  20 BVDD  20 P76, ANI6 

21 P06, INTP3  21 P94, TI030, TO03, A4  21 PDL0, AD0  21 P73, ANI3 

22 P40, SI00, RXD2  22 P93, TI021, A3  22 PDL1, AD1  22 P74, ANI4 

23 P41, SO00, TXD2  23 P96, TI051, TO51, A6  23 PDL2, AD2  23 P71, ANI1 

24 P42, SCK00  24 P95, TI031, A5  24 PDL3, AD3  24 P72, ANI2 

25 P30, TXD0, TO02  25 N.C.  25 PDL4, AD4  25 N.C. 

26 N.C.  26 P97, SI01, A7  26 N.C.  26 P70, ANI0 

Table 15: CN3, CN4, CN5, and CN6 connection to V850ES/KG1+ 
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4.3 78K0/KF1+ memory map 

 
The 78K0/KF1+ memory layout is shown in the table below. 
 

0xFFFF   
 SFR Area  
0xFF00  Free for application 
0xFEDF  software 
 Internal high speed RAM  
0xFB00   
0xFAFF   
 Reserved  
0xF800   
0xF7FF   
 Internal expansion RAM Free for application 
0xF400  software 
0xF3FF   
 External memory  
0xF000   
0xEFFF   
 Flash memory Free for application 

A
dd

re
ss

  
ar

ea
 

0x0000  software 

Table 16: 78K0/KF1+ memory map 

 
The K_Line - Play it!-2 does not reserve any resources of the 78K0S/KF1+ device, consequently all 
available memory of the device is free for application software. 
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4.4 V850ES/KG1+ memory map 
 
The V850ES/KG1+ memory layout is shown in the table below. 
 

0x3FFFFFF   
 SFR Area  
0x3FFF000  Free for user application 
0x3FFEFFF  software 
 Internal high speed RAM  
0x3FFD800   
0x3FFD7FF   
 Reserved  
0x1000000   
0x0FFFFFF   
 External memory  
0x0100000   
0x001FFFF   
 Flash memory Free for user application 

A
dd

re
ss

  
ar

ea
 

0x0000000  software 

Table 17: V850ES/KG1+ memory map 

 
The K_Line - Play it!-2 does not reserve any resources of the V850ES/KG1+ device, consequently all 
available memory of the device is free for application software. 
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5. K_Line - Play it!-2 installation and operation 

5.1 Getting started 
The windows based FPL FLASH programming software allows to select and download application 
programs to K_Line - Play it!-2 starterkit. As communication interface between PC host system and the 
K_Line - Play it!-2 board a USB interface line is needed. Before you can download and run a program, 
hardware and software must be installed properly. 
 

5.1.1 CD-ROM contents 
The CD-ROM shows following directory structure: 
 

 K_Line – Play it!-2 (F:) CD-ROM ROOT 

  Acrobat - Acrobat Reader for 32Bit Windows OS 

  Doc - Documentation 

  FPL - FPL FLASH programming software 

   Drivers  … USB driver 

   FPL  … FPL setup directory 

   PRM  … PRM parameter files 

  IAR Embedded Workbench 78K - IAR Embedded Workbench for 78K0/78K0S 

  IAR Embedded Workbench V850 - IAR Embedded Workbench for V850 

  SamplePrograms - Sample programs for K_Line – Play it!-2 

   AD Converter Demonstration  … AD converter demonstration 

   Reaction Time Measurement  … Reaction time measurement 

   Timer Demonstration  … Timer demonstration 

   UART Demonstration  … UART demonstration 

 

Table 18: K_Line - Play it!-2 CD-ROM directory structure  
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6. Hardware installation 
After unpacking K_Line - Play it!-2, connect the board to your host computer using the provided USB 
interface cable. When K_Line - Play it!-2 is connected, the USB driver needs to be installed on the host 
machine. Please refer to the following CHAPTER 7 SOFTWARE INSTALLATION. 
 

7. Software installation 
The K_Line - Play it!-2 package comes with several software demo packages: 
 
• IAR Systems Embedded Workbench for 78K0/78K0S, including C compiler, assembler, linker, librarian 

and IAR C-SPY debugger / simulator 
• IAR Systems Embedded Workbench for V850, including C compiler, assembler, linker, librarian  

and IAR C-SPY debugger / simulator 
• FPL FLASH programming software 
• Sample programs 
 
The IAR Systems Embedded Workbenches and the FPL FLASH programming GUI must be installed on 
your PC. For detailed installation hints, refer to the following chapters and to the corresponding 
documentation of the IAR Embedded Workbenches. 
 
The sample programs can be downloaded to the K_Line - Play it!-2 board directly from the CDROM. Only if 
you intend to modify or debug (simulate) the sample programs it is necessary to copy them to your local 
hard disk. 
 
Remark:  Before modification or re-building of sample programs, do not forget to remove 

“Read-only” attribute of copied files. 
 

7.1 IAR Systems Embedded Workbench for 78K0/78K0S installation 

To install the IAR Systems Embedded Workbench for 78K0/K0S including C-SPY debugger / simulator, 
select the SETUP program in the directory \IAR Embedded Workbench 78K\ew78k\ of the CDROM. 
The setup dialogues will guide you through the installation process. 
 

7.2 IAR Systems Embedded Workbench for V850 installation 
To install the IAR Systems Embedded Workbench for V850 including C-SPY debugger / simulator, select 
the SETUP program in the directory \IAR Embedded Workbench V850\ewv850\ of the CDROM. The 
setup dialogues will guide you through the installation process. 
 

7.3 FPL FLASH programming GUI installation 

To install the FPL FLASH programming GUI select the SETUP program in the directory \FPL\ of the 
CDROM. The setup dialogues will guide you through the installation process. 
 

7.4 Sample program installation 
The sample programs do not require any installation for download to the K_Line - Play it!-2 board. If the 
sample programs shall be modified it is required to copy them into any directory of your local hard disk. A 
file copy using the Windows explorer is the recommended procedure.  
 
Remark:  Before modification or re-building of sample programs, do not forget to remove 

“Read-only” attribute of copied files. 
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7.5 USB Driver Installation 

 
When the K_Line - Play it!-2 board and FPL is used, the driver needs to be installed on the 
host machine. Install the driver according to the following procedure: 

 
Installation on Windows 98SE/Me .........  Page 26 
Installation on Windows 2000 ...............  Page 28 
Installation on Windows XP ...................  Page 34 

 

7.5.1 Installation on Windows 98SE/Me 
 

1. When the K_Line - Play it!-2 board is connected with the host machine, the board is 
recognized by Plug and Play, and the wizard for adding new hardware is started.  Click 
Next>. 

 

Figure 5:  Add New Hardware Wizard (Windows 98SE) 

 
 

 
2. The window below is displayed.  So, check that "Search for a suitable driver ..." is selected, 

then click Next>. 
 

Figure 6: Search Method (Windows 98SE) 

 

Click. 

Check that "Search for a 
suitable driver ..." is selected. 

Click. 
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3. Check the "Specify a location" check box only and enter "C:\Program 

Files\NECTools32\FPL\DRIVER" in the address bar, then click Next>. 
 

Figure 7: Search Location Specification (Windows 98SE) 

 
 
 
 
 
 
 
 
備考  3.1ソフトウエアのインストール先のフォルダを変更した場合は， 

 
 

Remark If the installation destination folder is changed at the time of GUI software installation, 
enter "new-folder\DRIVER". 

 
 

4. The window below is displayed.  Click Next>. 
 

Figure 8: Checking Driver to Be Installed (Windows 98SE) 

 
 

 
 

<1> Check "Specify 
a location" only. 

<3>  Click. 

<2>  Enter "C:\Program Files\NECTools32\FPL\DRIVER". 

Click. 
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5. When the window below is displayed, the installation of the USB driver is completed.  Click 

Finish.  The installation of the USB Serial Port driver is then automatically performed. 
 

Figure 9: Installation Completion (Windows 98SE) 

 
 

 
 

7.5.2 Installation on Windows 2000 
 

1. When the K_Line - Play it!-2 board is connected with the host machine, the board is 
recognized by Plug and Play, and the wizard for finding new hardware is started.  Click 
Next>. 

 

Figure 10: Found New Hardware Wizard 1 (Windows 2000) 

 

Click. 

Click. 
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2. The window below is displayed.  So, check that "Search for a suitable driver ..." is selected, 

then click Next>. 
 

Figure 11: Search Method 1 (Windows 2000) 

 
 
 

3. Check the "Specify a location" check box only, then click Next>. 
 

Figure 12: Driver File Location 1 (Windows 2000) 

 
 

Click. 

Check that "Search for a 
suitable driver ..." is 
selected. 

Click. 

Check that "Specify a 
location" only is checked. 
ed.hed. 
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4. Enter "C:\Program Files\NECTools32\FPL\DRIVER" in the address bar, then click OK. 

 

Figure 13: Address Specification 1 (Windows 2000) 

 
 
 
 
 
 
 

Remark If the installation destination folder is changed at the time of GUI software installation, 
enter "new-folder\FPL\DRIVER". 

 
 

5. Click Next>. 
 

Figure 14: Driver File Search 1 (Windows 2000) 

 
 

Enter "C:\Program Files\NECTools32\FPL\DRIVER". 

Click. 

Click. 
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6. Click Finish to complete the installation of the USB driver. 

 

Figure 15: USB Driver Installation Completion 1 (Windows 2000) 

 
 
 

7. Proceed to the installation of the USB Serial Port driver.  Click Next>. 
 

Figure 16: Found New Hardware Wizard 2 (Windows 2000) 

 
 

Click. 

Click. 
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8. The window below is displayed.  So, check that "Search for a suitable driver ..." is selected, 
then click Next>. 

 

Figure 17: Search Method 2 (Windows 2000) 

 
 
 

9. Check the "Specify a location" check box only, then click Next>. 
 

Figure 18: Driver File Location 2 (Windows 2000) 

 
 

Click. 

Check that "Search for a 
suitable driver ..." is 
selected. 

Click. 

Check that "Specify a 
location" only is checked. 
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10. Enter "C:\Program Files\NECTools32\FPL\DRIVER" in the address bar, then click OK. 

  

    Figure 19: Address Specification 2 (Windows 2000) 

               
  
 
 
 
 
 

Remark If the installation destination folder is changed at the time of GUI software installation, 
enter "new-folder\DRIVER". 

 
 

11. Click Next>. 
  

   Figure 20: Driver File Search 2 (Windows 2000) 

 
 

  
  
  

Enter "C:\Program Files\NECTools32\FPL\DRIVER". 

Click. 

Click. 
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12. Click Finish to complete the installation of the USB driver. 

  

   Figure 21: USB Driver Installation Completion 2 (Windows 2000) 

                 
  
 

7.5.3 Installation on Windows XP 
 

1. When the K_Line - Play it!-2 board is connected with the host machine, the board is 
recognized by Plug and Play, and the wizard for finding new hardware is started.  Check 
that "Install from a list or specific ..." is selected, then click Next>. 

 

Figure 22: Found New Hardware Wizard 1 (Windows XP) 

 
 

 

Check that "Install from a list 
or specific ..." is selected. Click. 

Click. 
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2. Check that "Search for the best driver in these locations." is selected.  Check the "Include 

this location in the search:" check box and enter "C:\Program 
Files\NECTools32\FPL\DRIVER" in the address bar, then click Next>. 

 

Figure 23: Search Location Specification 3 (Windows XP) 

 
 

 
 
 
 
 
 

3. As shown below, "has not passed Windows Logo testing to verify its compatibility with 
Windows XP." is displayed.  Click Continue Anyway. 

 

Figure 24: Windows XP Logo Testing 3 (Windows XP) 

 

<1> Check that "Search for the 
best driver in these locations." 
is selected. 

<2> Check "Include this 
location in the search:" 
only. 

Click. 

<4>  Click. <3>  Enter "C:\Program Files\NECTools32\FPL\DRIVER". 
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4. When the window below is displayed, the installation of the USB driver is completed.  Click 

Finish. 
 

Figure 25: USB Driver Installation Completion 1 (Windows XP) 

 

 
 

5. Proceed to the installation of the USB Serial Port driver.  Click Next>. 
 

Figure 26: Found New Hardware Wizard 2 (Windows XP) 

 
 
 

Click. 

Check that "Install from a list 
or specific ..." is selected. Click. 
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6. Check that "Search for the best driver in these locations." is selected.  Check the "Include 
this location in the search:" check box and enter "C:\Program 
Files\NECTools32\FPL\DRIVER", then click Next>. 

 

Figure 27: Search Location Specification 2 (Windows XP) 

 
 
 
 
 
 
 
 
 

7. As shown below, "has not passed Windows Logo testing to verify its compatibility with 
Windows XP." is displayed.  Click Continue Anyway. 

 

Figure 28: Windows XP Logo Testing 2 (Windows XP) 

 

 

<1> Check that "Search for the best 
driver in these locations." is 
selected. 

<2> Check "Include this location 
in the search:" only. 

<4>  Click. <3>  Enter "C:\Program Files\NECTools32\FPL\DRIVER". 

Click. 
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8. When the window below is displayed, the installation of the USB driver is completed.  Click 

Finish. 
 

Figure 29: USB Serial Port2 Driver Installation Completion (Windows XP) 

 
 
 
 

 
 
 

Click. 
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7.6 Confirmation of USB Driver Installation 
 
After installing the two types of drivers, check that the drivers have been installed normally, 
according to the procedure below. When using the K_Line - Play it!-2 board in combination 
with FPL GUI, the information to be checked here is needed. 

 
 

By clicking the "Device Manager" tab, check that the drivers are installed normally. 
 

Figure 30: Device Manager 

 
 

For Windows 98SE/Me 
Caution  Do not select Update and Erase when communicating with the target 

device. 
 

For Windows 2000/XP 
Caution  Do not perform "Hardware Modification Scan" when communicating with the 

target device. 
 
 

Remark In the GUI port list box, the same communication port as COM? of USB Serial Port 
(COM?) needs to be selected. 

 
 If the drivers above are not displayed, or the mark "×" or "!" is prefixed, refer to 

CHAPTER 10 TROUBLESHOOTING. 
 

 

Check that "USB Serial Port 
(COM?)" is present. 

Check that "USB High Speed 
Serial Converter" is present. 
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7.7 Driver Uninstallation 
 

The driver uninstallation program is installed on the host machine when the FPL software is 
installed. Use the procedure below for driver uninstallation. 

 
 

1. When using Windows XP, log on as the computer administrator. When using Windows 
2000, log on as the Administrator. 

 
2. Double-click in the order from "My Computer" to "(C:)" to "Program Files" to "NECTools32" 

to "FPL" to "DRIVER".  "Ftdiunin.exe" is displayed.  Double-click "Ftdiunin.exe". 
  

     Figure 31: Driver Uninstallation 

 
 
 

3. Click Continue. 
 

Figure 32: Driver Uninstaller 

 

Double-click. 

Click. 
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4. Click Finish to complete driver uninstallation. 
 

    Figure 33: Completion of Driver Uninstallation 

 
 

Caution If the GUI software is uninstalled earlier, "Ftdiunin.exe" is also deleted.  At this time, 
delete "USB Serial Port (COM?)" and "USB High Speed Serial Converter" from Device 
Manager manually. 

 
 

Click. 
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8. FPL FLASH programming software 

8.1 Introduction 
 
The parameter files for the 78K0/KF1+ and V850ES/KG1+ devices are installed automatically 
during installation of FPL GUI, folder <FPL install-path>\PRM. Nevertheless, newest version of 
parameter file for the µPD78F0148HD and µPD70F3311 device can by download from the NEC 
Electronics Web site. 
 
Download the parameter file for the PG-FP4 from the following NEC Electronics Web site: 
 

http://www.ee.nec.de/updates 
 
Copy the parameter file downloaded from the NEC Electronics Web site into sub-directory 
<FPL.EXE-install-path>\PRM created during GUI software setup (refer to CHAPTER 7 
SOFTWARE INSTALLATION).. 

 
 

8.2 Starting up the GUI Software 
 

  •  GUI software startup 
 Select FPL.EXE from the start menu to start the FPL GUI software. 

 
 

 When the GUI software is started normally, the following screen appears. 
 

Figure 34: GUI Software Main Window 

 
 

Menu bar 

Toolbar 

Action log window 

Status bar 

Programmer 
parameter 
window 
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This window consists of the following items: 

   
Name Display Information 
Menu bar 
(displayed at the top) 

Displays menu items executable by the 
FPL. 

Toolbar 
(displayed under the menu bar) 

Displays frequently used commands as 
icons. 

Action log window 
(displayed under the toolbar) 

Displays an FPL action log. 
 

Programmer parameter window 
(displayed to the right of the action log 
window) 

Displays programming parameter 
settings. 
 

Status bar Displays status. 
 
 

8.3 Toolbar 

 
The toolbar contains buttons for starting the important procedures of the FPL. 

 

Figure 35: Toolbar Buttons 

 
[Device] → [Setup] button 

 
[File] → [Load] button 

 
[Device] → [Blank Check] button 

 
[Device] → [Erase] button 

 
[Device] → [Program] button 

 
[Device] → [Verify] button 

 
[Device] → [Autoprocedure(EPV)] button 
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8.4 Menu Bar 
 
Depending on the actual device status and device type, some menu items may be enabled or 
disabled. 

 
 

8.4.1 [File] menu 
Clicking the [File] menu displays the pull-down menu as shown below. 
This menu mainly contains commands related to file operation. 

 

       Figure 36: [File] Menu 

 
 

(1) [Load] command 
The [Load] command allows you to select a program file. 
The selected program file is programmed into the flash memory of the device by 
executing the [Program] command or [Autoprocedure(EPV)] command. 

 

Figure 37: HEX File Selection Window 

 
 

 The file selection window for program loading displays the most recently used directory to 
which a user program has been loaded.  After a user program is loaded, a checksum 
calculation is made and the result is displayed in the programmer parameter window. 

 [  Open  button] 
 Selects a user program as a program to be written to the target device. 

 
 [  Cancel  button] 
 Closes the window without selecting a program. 
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(2) [Quit] command 
 The [Quit] menu is the command for terminating the FPL GUI software.  Clicking  ×  on the 

right side of the task bar also terminates the FPL GUI software. 
 User settings are saved in the FPL.ININote file, so that the GUI software starts up next time 

with the same settings. 
 

Note FPL.INI is created in the Windows folder when Windows 98SE, Windows Me, or 
Windows XP is used. 

 When Windows 2000 is used, FPL.INI is created in the Winnt folder. 
 
 

8.4.2 [Device] menu 
Clicking the [Device] menu displays the pull-down menu as shown below. 
This menu mainly contains commands for programming operations such as deletion, 
programming, and verification on the target device. 

 

Figure 38: [Device] Menu 

 
 

(1) [Blank Check] command 
The [Blank Check] command allows you to make a blank check on the target device 
connected to the FPL.  If the flash memory of the target device is erased, a blank 
check is terminated normally.  If the flash memory is not completely erased, the 
indication "not blank" is provided.  Before starting programming, erase the flash 
memory of the target device. 

 
(2) [Erase] command 

The [Erase] command erases the flash memory of the target device connected to the 
FPL.  While the flash memory is being erased, the progress status is displayed in the 
action log window to indicate programmer operation. 
The execution on the [Blank Check] command before the [Erase] command is 
executed follows the setting of 'Command options' of the Advance tab displayed by 
selecting [Device] → [Setup]. 
Upon completion of [Erase] command execution, the GUI software displays the result 
of executing the command on the target device. 

  
 
 



K_Line - Play it! - 2  

46 

(3) [Program] command 
The [Program] command sends a specified user program to the target device and 
writes the program to the flash memory. 
The execution of Verify operation for detecting an error in user program 
communication from the FPL to the target device after the execution of the [Program] 
command follows the setting of the 'Command options' on the Advance tab displayed 
by selecting [Device] → [Setup]. 
During programming, the progress status is displayed in the action log window to 
indicate programmer operation.  This progress status display window displays the 
progress status on target device programming by percentage. 
Upon completion of [Program] command execution, the GUI software displays the 
result of executing the command on the target device. 

 
(4) [Verify] command 

The [Verify] command sends a specified user program to the target device connected 
with the FPL, and performs verification against the data written to the flash memory 
of the target device. 
During verification, the progress status is displayed in the action log window to 
indicate programmer operation.  This progress status display window displays the 
progress status of target device verification by percentage. 
Upon completion of [Verify] command execution, the GUI software displays the result 
of executing the command on the target device. 

 
(5) [Security] command 
 This command is not supported. 

 
(6) [Checksum] command 
 The [Checksum] command reads the checksum value of the target device connected with 

the FPL. 
 This value differs from the value displayed in the parameter window of the main window. 

 
(7) [Autoprocedure(EPV)] command 

The [Autoprocedure(EPV)] command executes the [Erase] command, [Program] 
command and [Verify] command in succession. 
When a user program is to be resent to the target device for comparison with the data 
written to the flash memory of the target device because of a user program 
communication error, execute the [Program] command by selecting [Device] → 
[Setup] and specifying 'Command options' on the Advance tab, then set the automatic 
execution of the [Verify] command. 
During EPV execution, the progress status is displayed in the action log window to 
indicate programmer operation.  For a selected command, its execution operation, 
and messages, refer to CHAPTER 9 HOW TO USE FPL. 
Upon completion of [Autoprocedure(EPV)] command execution, the GUI software 
displays the result of executing the command on the target device. 

 
(8) [Signature read] command 
 The [Signature read] command reads the signature information (device name, flash 

memory information, and so forth) of the target. 
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(9) [Setup] command 

The [Setup] menu allows you to make settings related to flash memory rewriting 
according to the user environment and to set command options.  Each time the GUI 
software is started, the most recently used parameter file (.PRM) is read and the 
settings are displayed.  The [Setup] menu allows you to modify the settings of items 
other than those items consisting of shadowed characters according to the user 
environment. 

 
(a) Standard setup 

This menu is used to set the environment for rewriting the flash memory of the target 
device. 
The mode of communication with the target, the operating clock, and so forth differ 
depending on the device used.  For details, refer to the manual of the device used, 
when making settings. 
The window shown below is opened. 

 

Figure 39: Device Setup Window - Standard 

 
 

This window shows all basic options that can be set in accordance with the user 
environment and target device. 

 
[  OK  button] 
Clicking the  OK  button saves the settings on the Standard and Advance menus and 
closes the window. 

 
[  Cancel  button] 
Clicking the  Cancel  button closes the window without saving the settings on the 
Standard and Advance menus. 
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<1> Parameter file 
This file holds parameters and timing data required to rewrite the flash memory of 
the target device.  Do not modify the data in the parameter file because the data is 
related to the guarantee of rewrite data. 
The parameter file is protected by the checksum function.  If the checksum result 
indicates an error, the FPL does not accept the parameter file. 

 
 

Figure 40: Setup Window - Parameter File Selection 

 
 
 

 

Figure 41: Parameter File Selection Window 

 
 

[  PRM File Read  button] 
A window for specifying a parameter file is displayed.  Specify a desired file then 
click Open. 
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<2> Communication interface to device 
"Communication interface to device" is used to select a channel for communication 
between the K_Line – Play it!-2 board and host machine. 

 

Figure 42: Setup Window - Communication interface to device 

 
 

[Port list box] 
Select a channel for communication between the K_Line – Play it!-2 board and host 
machine. 

•  COM1 to COM16 
 

Remark Selectable ports can be checked using Device Manager.  For details, 
refer to CHAPTER 7.6 Confirmation of USB Driver Installation. 

 
[Speed list box] 
Select a communication rate for the selected communication channel from the 
following: 

•  9600 bps  
•  19200 bps  
•  38400 bps  

 
Remark For selectable communication rates, refer to the user's manual of the 

device used. 
 

<3> Supply oscillator 
"Supply oscillator" is used to select a clock that determines programming, data 
transfer, and a transfer rate. 

 

Figure 43: Setup Window - Supply Oscillator Selection 

 
 

[Frequency box] 
Sets the clock frequency of the target system. 
The range of operating frequency varies from one device to another.  So, check the 
specifications of the device used before making a setting. 
 
[Multiply rate] 
Specifies the division rate or multiplication rate of the target device. 
If the target device has an on-chip PLL circuit, enter a division rate or multiplication 
rate according to the use environment. 
The selectable division rate or multiplication rate differs depending on the device.  
Check the specifications of the device used before making a setting. 
If the target device does not have an on-chip PLL circuit, select "1.0". 
On the initial screen, the default setting is displayed according to the parameter file. 
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<4> Operation Mode 
The setting of "Operation Mode" may divide the flash memory of some target 
devices into blocks or areas. 
This menu is used to select an operation mode of the flash memory.  Some devices 
do not have the block and area division modes, and some devices have only one of 
the modes.  In these cases, a nonexisting mode is unchoosable. 

 

Figure 44: Setup Window - Operation Mode 

 
 

[When Chip is selected] 
The entire flash memory area of the target device is subject to rewrite processing. 
 
[When Block is selected] 
Specify the Block number range subject to rewrite processing by using Start/End. 
The Start/End list boxes display the Block numbers where the flash memory of the 
target device is configured. 

 
[When Area is selected] 
Specify the Area number range subject to rewrite processing by using Start/End. 
The Start/End list boxes display the Area numbers where the flash memory of the 
target device is configured. 
 
[Show Address check box] 
Specify whether numbers or addresses are displayed in the Start/End list boxes. 
If this check box is checked, addresses are displayed. 
If this check box is not checked, numbers are displayed. 

 
 
 



K_Line - Play it! - 2  

51 

(b) Advance setup 
The Advance setup menu is used to specify the command options and security flag 
settings. 
When "Advance" is clicked, the following window is displayed: 

 

Figure 45: Device Setup Window - Advance 

 
 

<1> Command options 
This dialog box is used to specify the FPL flash processing command options. 

 

Figure 46: Setup Window - Command options 

 
 

[Blank check before Erase check box] 
If this check box is checked, blank check is made before the Erase command or 
EPV command is executed. 
If the result of a blank check indicates OK, erase processing is not executed. 

 
[Read verify after Program check box] 
If this check box is checked, write data is sent from the programmer after execution 
of the Program command and EPV command, then the data is verified against the 
data written to the flash memory. 

 
[Security flag after Program check box]  Not usable 

 
[Checksum after Program check box] 
If this check box is checked, the flash memory checksum value of the target device 
is read from the target device after execution of the Program command and EPV 
command. 
This value differs from the value displayed in the parameter window of the main 
window. 

 
<2> Security flag settings  Not usable 
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8.4.3 [View] menu 

Clicking the [View] menu displays the pull-down menu shown below. 
This menu contains commands for setting whether to display the toolbar and status bar. 

 

Figure 47: [View] Menu 

 
 
 

(1) [Toolbar] command 
 Checking the [Toolbar] command displays the toolbar.  Unchecking the command hides 

the toolbar. 
 

 
(2) [Status Bar] command 
 Checking the [Status Bar] command displays the status bar.  Unchecking the command 

hides the status bar. 
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8.4.4 [Help] menu 

Clicking the [Help] menu displays the following pull-down menu: 
 

Figure 48: [Help] Menu 

 
 
 

(1) [About FPL] command 
 The [About FPL] command opens the program entry window as shown below and indicates 

the version. 
 Clicking  OK  terminates the display. 

 

Figure 49: About FPL Window 
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8.5 Programmer Parameter Window 
 

This window displays the settings of the programming parameters. 
 

Figure 50: Programmer Parameter Window 

 
 

[Device] 
Updated after communication with the target device to display information about the target 
device. 

 
[Parameter file] 
Updated after [Setup] command execution to display information about a read parameter file. 

 
[Load file] 
Updated after [Load] command execution to select information about a selected program file. 
 
[Connection to device] 
Updated after [Setup] command execution to display information about the connection with the 
target device. 
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9. How to use FPL FLASH programming software 
 

This chapter explains the basic operations of the FPL GUI for programming the K_Line - Play it!-2 
board. This chapter covers how to start the system, execute the EPV command, and program the target 
device. On the following pages the FLASH programming via FPL is shown based on the V850ES/KG1+ 
device. The programming of the 78K0/KF1+ device is similar! 
 
The conditions of the series of operations described in this chapter are as follows: 
 
Hardware configuration of K_Line - Play it!-2: 
 
Base board :  K_Line - Play it!-2 
CPU module :  V850ES/KG1+ 
Target device :  µPD70F3311 
Clock :  8 MHz 
Voltage level :  5 V 
 
Software configuration of FPL: 
 
Parameter file: 70F3311.PRM 
Clock setting :  8 MHz Multiplied by 1 
Port :  COM4 (38400 bps) 
Operation mode: Chip 
Write HEX :  V850_UART_DEMO.hex  
Option setting :  Blank check before Erase 

 

(1) Installing the FPL GUI software 
Install the FPL GUI software on the host machine you are using, by referring to CHAPTER 7 
SOFTWARE INSTALLATION (if the software has not been installed yet). 

 

(2) Installing the driver 
Install the USB driver on the host machine you are using, by referring to CHAPTER 7 
SOFTWARE INSTALLATION (if the driver has not been installed yet). 

 

(3) Installing the parameter file 
The parameter files for the 78K0/KF1+ and V850ES/KG1+ devices are installed automatically 
during installation of FPL GUI, folder <FPL install-path>\PRM. Nevertheless, newest version of 
parameter file for the µPD78F0148HD and µPD70F3311 device can by download from the NEC 
Electronics Web site. 
 
Download the parameter file for the PG-FP4 from the following NEC Electronics Web site: 
 

http://www.ee.nec.de/updates 
 
Copy the parameter file downloaded from the NEC Electronics Web site into sub-directory 
<FPL.EXE-install-path>\PRM created during GUI software setup (refer to CHAPTER 7 
SOFTWARE INSTALLATION).. 
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(4) Connecting and starting 
 
<1> Set the K_Line - Play it!-2 board to the FLASH programming mode by switching SW4/S1 to 

ON: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
<2> <Plug and Play> Connect the K_Line - Play it!-2 board with the host machine via the USB 

cable. If the connection was already done, press the reset button SW1 to release the FLASH 
programming mode. 

 

SW4 Setting 
S1 ON 
S2 OFF 
S3 OFF 
S4 OFF 
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<3> Start the FPL GUI. 

 

Figure 51: GUI Software Startup Screen 

 
 

(5) Setting the programming environment 
<1> Select [Device] → [Setup] from the menu bar. 
<2> The Standard dialog box for device setup is activated. 
 

Figure 52: <Standard Device Setup> Dialog Box 
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<3> Click PRM File Read to open the parameter file selection window. 
 Select the parameter file “70F3311.prm” then click Open. 
 

In case of programming the 78K0/KF1+ device please chose the 
“78F0148HD.prm” file. 

 

Figure 53: Parameter File Selection 

 
 

 
<4> From the Port list box, select the communication port that matches the host machine being 

used. Select the communication speed of the Host connection. 
 

Figure 54: Port Selection 

 
 

 
Remark Selectable ports can be checked using Device Manager.  For details, refer to 7.6 

Confirmation of USB Driver Installation. 
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<5> Set "Supply oscillator" according to the specifications of the K_Line - Play it!-2 board,  

“Frequency = 8.00 MHz” and “Multiply rate = 1.00”. In "Operation Mode", please 
specify the “Chip” mode. The following figure shows the recommended settings: 

 

Figure 55: <Standard Device Setup> Dialog Box after Setting 

 
 
 

<6> Switch to the Advance dialog box. 
 

Figure 56: <Advance Device Setup> Dialog Box  

 
 

 
 <Command options>  

Blank check before Erase :  Checked 
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<7> Click the OK button.  The GUI software sets the parameters. 
 When the settings have been completed, the following screen is displayed: 

 

Figure 57: Completion of Parameter Setting 

 
 
 

(6) Selecting a user program 
<1> Select [File] → [Load]. 
<2> Select a program file to be written to the target device, then click Open. 
 

Figure 58: After Downloading 

 
 

The display is updated. 

"Success read HEX file." is 
displayed. 

"PRM File Read OK." is displayed. 

The display is updated. 
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(7) [Autoprocedure(EPV)] command execution 
Select [Device] → [Autoprocedure(EPV)] from the menu bar. 
When the [Autoprocedure(EPV)] command is executed, Blank Check → Erase → Program and 
FLASH Internal Verify are executed sequentially for the µPD70F3311 device. 

 

Figure 59: After EPV Execution 

 
 
  

(8) Terminating the GUI 
Select [File] → [Quit] to terminate the GUI software. All settings executed so far are saved in the 
FPL.INI file, so that those settings can be reused when the GUI software is restarted. 

 

(9) Execute “V850_UART_DEMO” application 
Set the K_Line - Play it!-2 board to the normal operation mode by switching SW4/S1 to OFF. 
< Plug and Play> the K_Line - Play it!-2 board to start in normal operation mode or press the reset 
button SW1 to release the normal operation mode. 

 

(10) Restarting the GUI 
When the system is restarted, the same screen as shown in Figure 58 appears. 

 

"...finish" is displayed. 
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10. TROUBLESHOOTING 
 

In driver installation, recognition based on Plug and Play is disabled. 
 

Cause: 
The USB connector may not be inserted normally into the USB port of the personal computer. 
Action: 
Check that the USB connector is inserted fully into the USB port of the personal computer. 
Alternatively, disconnect the USB connector, then insert the USB connector again after a while. 
 
 
The driver file cannot be found at a specified location. 

 
Cause: 
The FPL FLASH programming software may not be installed correctly. 
Action: 
Install the GUI software again by referring to CHAPTER 7 Software Installation. 

 
 

In checking by Device Manager, "USB Serial Port" or "USB High Speed Serial 
Converter" is not displayed.  Alternatively, the "!" or "×" is prefixed. 

 
Cause: 
The USB connector may not be inserted normally into the USB port of the personal computer. 
Action: 
Check that the USB connector is inserted fully into the USB port of the personal computer. 
Alternatively, disconnect the USB connector from the USB port, then insert the USB connector 
again after a while. 

 
Cause: 
The driver may not be installed correctly. 
Action: 
<1> When this product is connected to the personal computer, right-click the driver marked 

with "!" or "×". 
 Click Erase when displayed. 
<2> On Device Manager, execute [Hardware Modification Scan]. 
<3> Install the driver again with Plug and Play. 

 
Cause: 
The device may not be recognized (in the case of connection with the USB hub). 
Action: 
Try the following: 

•   Disconnect the USB connector, then insert the USB connector again. 
•   Connect the USB connector to another port of the USB hub. 

If the same symptom occurs, do not use the USB hub, but directly connect the connector to 
the USB port of the personal computer. 

 
 

When this product is connected with a personal computer, the "Add New Hardware 
Wizard" screen is displayed. 

 
Cause: 
If the USB connector of this product is not inserted into the USB port used at the installation 
time but into another USB port, this product may be recognized as a new hardware item. 
Action: 
Install the driver by referring to CHAPTER 7.5 USB Driver Installation. 
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Communication with the K_Line - Play it!-2 board is disabled. 

 
Cause: 
The driver may not be installed correctly. 
Action: 
Check if "USB Serial Port" and "USB High Speed Serial Converter" are installed correctly by 
referring to CHAPTER 7.5 Driver Installation. 

 
Cause: 
The COM port selected via the “Port list box” within device setup menu of FPL may not be set 
correctly. 
Action: 
Set the port checked using Device Manager. 

 
Cause: 
The K_Line - Play it!-2 board is operating in normal mode. 
Action: 
Set the board to the FLASH programming mode by setting SW4 switch S1 to ON. 
 

 
Cause: 
The PRM file selected in [Device Setup] may be incorrect. 
Action: 
Use the corresponding PRM file that matches the target device. For information about the 
PRM file, refer to CHAPTER 8 FPL FLASH programming software. 

 
Cause: 
The setting of "Supply oscillator" in [Device Setup] may be incorrect. 
Action: 
Make a correct setting according to the specifications of the target device. 
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11.  Sample programs 

11.1 General Introduction 
Each of the sample programs is located in a single directory, which will be called main-directory of the 
sample. This main directory of each sample contains the complete project inclusive all output files of the 
development tools. All sample programs use the same directory structure: 
 
 

 _78K0 78K0/KF1+ project and output files 

  Debug  output files for IAR C-SPY debugger / simulator 

  Release  output files for 78K0/KF1+ CPU module (i.e. Intel HEX file) 

  Settings  configuration files, IAR Embedded Workbench 

  78K0_uart_demo.dep 
 dependency information file, IAR Embedded Workbench 

  78K0_uart_demo.ewd  project setting file, IAR C-SPY debugger 

  78K0_uart_demo.ewp 
 project file, IAR Embedded Workbench 

 _V850 V850ES/KG1+ project and output files 

  Debug  output files for IAR C-SPY debugger / simulator 

  Release  output files for V850ES/KG1+ CPU module (i.e. Intel HEX file) 

  Settings  configuration files, IAR Embedded Workbench 

  V850_uart_demo.dep 
 dependency information file, IAR Embedded Workbench 

  V850_uart_demo.ewd  project setting file, IAR C-SPY debugger 

  V850_uart_demo.ewp 
 project file, IAR Embedded Workbench 

  io70f3311.ddf 
 device description file, IAR C-SPY debugger 

  io70f3311.sfr  special function register definition file, IAR C-SPY debugger 

 inc C header files 

 settings configuration files, IAR Embedded Workbench 

 source C source files 

 xcl xcl files 

 78K0_uart_demo.eww workspace file, IAR Embedded Workbench 78K0/78K0S 

 V850_uart_demo.eww workspace file, IAR Embedded Workbench V850 

Table 19: Example directory structure 

 
The main directory contains only the workspace files for the IAR Systems Embedded Workbench 
78K0/78K0S and V850. All source files are located in the directory /source and the /inc directory 
contains the header files. The /xcl directory contains the linker control files of the 78K0/KF1+ and 
V850ES/KG1+ device. Each sample project uses two targets for each microcontroller device. One target is 
the IAR C-SPY debugger / simulator directory /Debug and the other is the K_Line – Play it!-2 hardware 
directory /Release. 
 
All output files of the development tools for the corresponding target 78K0 or V850 are generated in the 
directories /Debug and /Release. 
 
For details of using IAR Embedded Workbench and the IAR C-SPY debugger / simulator please refer to the 
manuals. 
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Figure 60: IAR Embedded Workbench 78K0/K0S 

 

 
Figure 61: IAR Embedded Workbench V850 
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Figure 62: IAR C-SPY Debugger / Simulator 78K0/78K0S 

 

 
Figure 63: IAR C-SPY Debugger / Simulator V850 
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11.2 ADC demo 

This sample program simulates a simple volt meter. By using the integrated ADC, the voltage supplied to 
ADC on input channel 0, port P20 of 78K0/KF1+ and P70 of V850ES/KG1+ device, is measured. The input 
voltage is adjusted by potentiometer R14. The board shows the measured voltage by driving the LC display. 
The output format can be changed by pressing button SW2. 
 
 

Used Internal Peripherals Used External Parts 
Timer00 Character LC display 
Timer01 Potentiometer R14 
Timer50 Button SW2 
A/D converter Button SW3 
 LED’s D1- D4 

 
 
To run the ADC demo please set the configuration of switch SW4 the following: 
 
 

SW4 Setting 
S1 OFF 
S2 OFF 
S3 don’t care 
S4 don’t care  
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11.3 ReacTime demo 

This sample program demonstrates a reaction time measurement. After the button SW3 is pressed the 
application waits for a random time duration between 0.50 and 3.45 seconds. Then the measurement starts 
by incrementing a reaction counter every 50ms. The actual counter value is shown by a bar graph using the 
character LC display until the next keystroke of button SW3. When the button SW3 is pressed again, the 
measurement stops and the reaction time is shown on the LC display. Pressing button SW2 starts a new 
measuring cycle. 
 
 

Used Internal Peripherals Used External Parts 
Timer00 Character LC display 
Timer01 Button SW2 
Timer50 Button SW3 
 LED’s D1- D4 

 
 
To run the ReacTime demo please set the configuration of switch SW4 to the following: 
 
 

SW4 Setting 
S1 OFF 
S2 OFF 
S3 don’t care 
S4 don’t care  
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11.4 Timer demo 

This sample program demonstrates a real time clock. After the program is started the watch timer is 
initialized to generate an exact clock reference, based on the 32.768 kHz sub-clock. The actual time is 
displayed using the LCD module. By pressing button SW2 / SW3 the time can be adjusted. 
 
 

Used Internal Peripherals Used External Parts 
Timer00 Character LC display 
Timer01 Button SW2 
WatchTimer Button SW3 
 LED’s D1- D4 

 
 
To run the Timer demo please set the configuration of switch SW4 to the following: 
 
 

SW4 Setting 
S1 OFF 
S2 OFF 
S3 don’t care 
S4 don’t care  
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11.5 UART demo 

This sample program simulates a temperature meter with serial communication channel. The sample 
program does a cyclic measurement of the input voltage of ANI2 analogue input, equal to port P22 of 
78K0/KF1+ and port P72 of V850ES/KG1+ device, connected to the temperature sensor KTY13-5. The 
temperature is calculated and the result is transferred via UART0 to a terminal program running on the host 
machine. The data transfer speed is set to 115200 bps per default. Additional the temperature is displayed 
on the LCD. Before the temperature measurement is started the calibration of the temperatures sensor has 
to be done, by adjusting the temperature offset via button SW2 and SW3. 
 
 

Used Internal Peripherals Used External Parts 
Timer00 Character LC display 
Watch Timer Temperature sensor KTY13-5 
A/D converter Button SW2 
UART0 Button SW3 
 LED’s D1- D4 

 
 
To run the UART demo please set the configuration of switch SW4 to the following: 
 
 

Setting SW4 
78K0/KF1+ 

CPU module 
V850ES/KG1+ 
CPU module 

S1 OFF OFF 
S2 OFF OFF 
S3 ON OFF 
S4 OFF OFF 
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12. Connectors and Cables 
 

12.1 USB host connector CN6 
 

Figure 64: Connector CN6, USB Mini-B Type Host Connector Pin Configuration 

1 5

 
 
 

Table 20: Pin Configuration of USB Connector CN6 

USB Connector 
CN6 

Signal Name 

1 VBUS 
2 DM 
3 DP 
4 N.C. 
5 GNDBUS 

 
 

For connection with the host machine, use a USB cable (Mini-B type). For confirmation, 
NEC Electronics used only the USB cable delivered with the K_Line - Play it!-2 board. 
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12.2 USB interface cable (Mini-B type) 

 

 
Figure 65: USB interface cable (Mini-B type) 
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13. Schematics 

 
Figure 66: K_Line - Play it!-2 baseboard schematics
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Figure 67: K_Line - Play it!-2 78K0/KF1+ CPU module schematics
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Figure 68: K_Line - Play it!-2 V850ES/KG1+ CPU module schematics 


